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NOTE:  Backup Now 5 Help File                                                                                                 [Word Count: 12,502] 
Welcome 
 
About Backup Now 5®  
 

Welcome to Backup Now 5 
Backup Now 5 is a powerful backup program for use with your CD-Recordable (CD-R) or CD-Rewritable (CD-RW) 
drives. It is a powerful, yet simple, program to effortlessly create scheduled backups of your crucial data, without 
requiring the hours of learning that other backup solutions usually entail.  

This User’s Guide is unified in that Windows 2000/XP/Vista share common information. In each section, and as 
required, notes have been included where there are particulars pertaining to Windows 2000/XP/Vista operation, 
performance, or use.   

About Backup Now 5 

Backup Now 5 handles the backup of your important files. Its intuitive user interface allows you to instantly navigate 
your way around your computer to locate files easily and the familiar Windows interface makes backing up your 
valuable data easy. Featuring our EasySteps™ interface, backing up or restoring your files is a simple three-step 
process.  

Step 1 – Select what files to backup/restore;  

Step 2 – Select where to backup or restore the data;  

Step 3 – Select when you want the data backed up or how to restore. 

Backup Now 5® Version 5.0 now provides even more flexibility and power to meet your backup needs. New 
features of Version 5.0 include xml job format, job management monitor and data migration – all of this in addition 
to the extensive list of features provided in previous versions.  

Backup Now 5 offers the following advantages, making it the best and easiest solution for backing up 
your valuable data: 

• Takes advantage of 32-bit power of Windows 2000/XP/Vista and supports long file names. 
• Backup to CD-R/RW drives, DVD±R/±RW/±R DL/±RW DL/-RAM drives, BD-R/BD-RE/BD-R DL/BD-RE DL 

drives, jaz & zip drives and local and network attached hard drives. 
• User selectable file level backup and restore. 
• Supports new and changed file backups.  
• Supports data compression. 
• Backup data from any drive source connected to your computer. 
• Backup and restore across multiple discs. (Media Spanning) 
• Backup and restore across multiple hard drives. (Hard Drive Spanning) 
• Backup and restore using an FTP server. 
• Multi-burner support on CD & DVD devices. (Drive Spanning) 
• Run backup jobs instantly or schedule them for later execution. 
• Schedule backup jobs once or repetitively, on a daily, weekly or monthly basis. 
• Append backup data or overwrite existing data on CD/DVD-RW devices. 
• Exclude specific file types from file level backups. 
• Backup and restore your personal computer profile (Profile Backup) 
• Full backup and restore reporting. 
• Time sensitive file replacements on restore operations. 
• Restore data to alternate locations. 
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Basic Configuration and Setup 
 
What's new in Backup Now 5? 
 

New Features in Backup Now 5: 

• Run concurrent backup jobs with Backup Now 5. 
• Use the new Job Management feature to refresh, run, stop, delete, and modify your backup job. 
• Reallocate or “archive” your NTI backup files to free up space by using the new Migration feature. 
• Backup Now 5 also includes several other feature enhancements (reports, utilities, compare). 

  Backup Now 5 
PROGRAM FEATURES BackupNOW! 4 Standard Continuous Image Advanced 

Backup your data to a disk file? X X X X X 

Restore backup data to an alternative location? X X X X X 

Backup specific files or folder? X X X X X 

Restore specific files or folders? X X X X X 

Incremental backups? X X X X X 

Schedule the backup for a specific time or date? X X X X X 

Execute backups automatically on a daily, weekly, or 
monthly basis? 

X X X X X 

Backup and restore a network drive? X X X X X 

Backup network files from another computer? X X X X X 

Supports continuous backups?   X  X 

Supports drive based backups?    X X 

Supports Open File?     X 

Supports file migration?  X X X X 

Supports Concurrent backup job?  X X X X 
 
 

 
Backup Now Editions 
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Toolbar 

 

Toolbar buttons are used as shorthand for menu commands. Each toolbar button represents a frequently used 
command. The display of these buttons is context-sensitive in that only buttons relevant to the current context are 
shown and enabled. 

 

Backup - Select this button to backup files. Some editions of Backup Now 5 may not have all the 
features mentioned below: 

HOW TO BACKUP? 

 

The File Based Backup feature was designed for specific folder or profile 
backup such as your personal Microsoft Outlook(R), My Documents, 
Favorites bookmark, installed fonts, and the contents of your desktop. 

The Continuous Backup feature was designed for backing up specific files 
or folders on a continuous basis. You can select save options and 
schedule a backup. 

The Drive Based Backup feature was designed for drive backups.  You can 
backup your whole physical hard drive or select an individual logical drives 
(C:\, D:\). 

 

 

Restore - Control what, where, and how Backup Now 5 will do a restore operation from the Restore 
Options dialog. 

 

Compare - Select what and where to compare backup files. 

 

Migrate - Select how, what, and where to migrate data files. 

 

Jobs - View various backup, restore, and migration job status. 
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Utilities - Backup Now 5 contains several useful utilities that will help you in better managing your 
systems, as well as extend the usage of a CD/DVD media. It also includes an erase utility, which 
will erase the contents of a CD-RW, DVD±RW or DVD±RW DL.   

 

New - Create new backup/restore/migrate jobs. 

 

Help - Display help for current task or command help. 

 

Backup Now 5 generates a completion report for every backup, restore or compare operation. 
These reports can contain a list of all selected files and their status. View these reports to make 
sure that an operation was completed successfully. A report may be viewed upon the completion of 
an operation. All reports are saved in the Backup Now 5 reports folder where they can be viewed 
later if necessary. 

 

Backup Options - Enable general, media, filter, security, notify and other options. 
Restore Options - Report all files that were restored. 

Migrate Options - Keep or delete original copy and enable other media options. 
 
 

 

 
 
Menus 

All Backup Now 5 menus can be invoked by a single left-button click of a mouse on the menu title. Menu items are 
aligned on the left, with keystroke shortcuts (if applicable) displayed on the corresponding right side. The 
underlined character of a menu item, if pressed (through the keyboard), will have the same effect as if the menu 
item were selected with the mouse. 

 

New - Create a new backup/restore/migrate job. 

Exit - Close the Backup Now 5 program. 

 

Select - Select all the check boxes of the highlighted item. 

Deselect - Uncheck all the check boxes of the highlighted item. 

Find Files... - Bring up the Find Files dialog box and search for a file within the 
current backup volume to restore. (This option is only available in Restore mode.) 
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Backup - Switch Backup Now 5 to Backup mode. 

Restore - Switch Backup Now 5 to Restore mode. 

Compare - Switch Backup Now 5 to Compare mode. 

Migrate - Switch Backup Now 5 to Migrate mode. 

Utilities - Open Utilities window. 

Jobs - Open job overview window. 

Refresh - Refresh current window. 

Start BUN Sys tray - Start Backup Now 5 system tray. 

 

Help Topics - Display the Backup Now 5 online help system. 

Register my NTI software -  www.ntius.com/registration.asp. 

Upgrade to Advanced Edition - 
https://secure.ntius.com/backup_now_estore.asp?p=upgrd&oemid=888  

Backup Now 5 Home Page -  www.ntibackupnow.com/main_backupnow.htm. 

Frequently Asked Questions Page - www.ntius.com/faq.asp. 

Software Update Download Page - 
www.ntius.com/backup_now_downloads.asp?p=updates 

Technical Support Page - www.ntius.com/support.asp. 

About Backup Now 5 Suite 5.0... - View the version number and program 
information about Backup Now 5. 

 Right-click Backup Now 5 icon on the system tray to access the Windows Services: 

Backup Now 5 Services - Select to start or stop Shadow service. 

Launch Backup Now 5 - Open Backup Now 5 application. 

Help - Show help manual. 

Exit - Close the Backup Now 5 application. 
 
 

 

Using Backup Now 5 
 
Getting Started 
 
Getting Started 
 

Getting Familiar with Backup Now 5 
The first thing that you will notice about Backup Now 5 is how it automatically customizes itself based on the 
operation you wish to perform. You can select from the Backup, Restore, Compare and Migrate operations with the 
click of a button from the main toolbar and Backup Now 5 does the rest.  

EasySteps(TM) Interface 
Backup Now 5’s intuitive EasySteps™ interface guides you through the backup, restore and compare process.  

Step 1 — Defines the data to be used or "What" data to backup, restore or compare.  

http://www.ntius.com/registration.asp
https://secure.ntius.com/backup_now_estore.asp?p=upgrd&oemid=888
http://www.ntibackupnow.com/main_backupnow.htm
http://www.ntius.com/faq.asp
http://www.ntius.com/backup_now_downloads.asp?p=updates
http://www.ntius.com/support.asp
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Step 2 — Defines the target destination or "Where" to backup, restore or compare the source data.  

Step 3 — Tells Backup Now 5 "When" to backup or "How" to restore the selected source data.  

Backup Now 5 splits these into separate steps for ease of use.  

 
Backup - Select this button to backup files. Some editions of Backup Now 5 may not have all the 
features mentioned below: 

HOW TO BACKUP? 

Select Continuous Backup for backing up specific files or folders on a 
continuous basis. You can select the number of previous file version to save, 
set default file names for backups or type a custom backup file name. 

 

Select File Based Backup for specific folder or profile backup such as your 
personal Microsoft Outlook(R), My Documents, Favorites bookmark, 
installed windows fonts, and the contents of your Desktop. 

Select Drive Based Backup for drive backups.  A backup set can be saved 
on any CD or DVD recorder on your computer or any device that provides 
drive letter access installed or connected to your system, including network 
hard disk. 

 

 

Restore - Control what, where, and how Backup Now 5 will do a restore operation from the Restore 
Options dialog. 

 

Compare - Select what and where to compare backup files. 

 

Migrate - Select how, what, and where to migrate files. 

 

Jobs - View various backup, restore, and migration job status. 

 

Utilities - Backup Now 5 contains several useful utilities that will help you in better managing your 
systems, as well as extend the usage of a CD/DVD media. It also includes an erase utility, which will 
erase the contents of a CD-RW, DVD±RW or DVD±RW DL.   

 
 

 
Selecting files in Backup Now 5 
 

Selecting files in Backup Now 5 
Backup Now 5 uses a Window's Explorer style view when you need to select specific files or folders for any step of 
the selected operation. The selection view is split vertically into two panes. The left pane, Collapsible Tree Pane, 
displays the system collapsible tree.  

• The right pane, File Information Pane, displays detailed information about items selected from the system 
collapsible tree.  

• Branches or nodes on the tree can be expanded or collapsed by clicking on the + or - to the left of the item 
or by double clicking on the item itself.  

• The two panes may be resized horizontally by dragging the splitter bar between them.  
• Dragging the splitter bar to the left will display more of the file information pane while reducing the visible 

portion of the collapsible tree pane. 

The file information pane has four columns that display the file/folder name, its size, the file type and the last 
modified date. The files may be sorted on any one of these columns by clicking on the column header.  

• By default, files are sorted alphabetically (ascending) by name. Click the Name column heading to sort 
them in descending order by name.  
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• Items listed in the file information pane may include a small checkbox to the left of their name indicating 
that they can be selected within Backup Now 5. Simply click the box to include that item and all items below 
it in the file structure in the current operation. For example, if you check the box to the left of the C: drive 
icon, all files and folders on your C drive will be selected automatically.  

• If you expand the C drive from the collapsible tree and then check the box to the left of the Autoexec.bat file 
then only the Autoexec.bat file is selected for the current backup, restore or compare operation. 

Ä  To Select a file/folder: 

1. Navigate the collapsible tree to locate the desired file, folder or drive. 

2. Check on the box to the left of the desired item. 

Ä  To Deselect a file/folder: 

1. Navigate the collapsible tree to locate the desired file, folder or drive. 

2. Uncheck on the box to the left of the desired item. 
 
 

 
Backup 
 
File Based Backup 
 
Step 1: What to backup? 
 

Ä Step 1:   What to backup? 
1. Click on the Backup icon from the toolbar or select Backup from the View menu. 

2. Select the File Based Backup tab and click the Step 1 button on the left-hand side of the main window. 

3. If you wish to backup your profile, make sure you select the My Profile tab. Otherwise, use the My 
Folders tab to browse for the desired files and folders. For more information on profile backups, see 
Using Profile Backups. 

4. Select the folders or files you wish to backup and choose one of the following options:  
• All selected files. 
• New and changed files only. (See Incremental Backup for additional information.) 

5. Click the Step 2 button to select the destination of the backup file. 
 
 

 

 
 
Step 2: Where to backup? 
 

Ä Step 2:   Where to backup?  

1. Select one of the following destination for your backup files from the drop-down window: (a) Hard disc 
drives,  (b) Network drives, (c) Device with removable storage, and (d) FTP server. 
• If you have chosen to backup to a remote FTP server, enter the correct FTP server information. 
• Select more than one drive to hold your backup set (drive spanning) if your destination does not 

have enough space. 
2. Change the corresponding backup file name if desired. 

File Based Backup File Extensions 
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.NBS The .NBS file defines the description of the file-based backup information and acts as an index for the 
application to search for data files. 

3. Click the Step 3 button to select when to backup files. 
 
 

 

 
 
Step 3: When to backup? 
 

Ä Step 3:   When to backup? 

1. Select one of the following schedule options: 

Now Backup files now. 

Later Backup files at a later time only. Enter the start time and set the specific month, day, and year to 
begin backup. 

 

Hourly Backup files hourly. Enter the start time and set the interval in hours and minutes to begin 
backup. 

 

Daily Backup files daily. Enter the start time and select the days to begin backup. 

 

Weekly Backup files weekly. Enter the start time and select the day to begin backup from the drop-down 
menu. 

 

Monthly Backup files monthly. Enter the start time and select the day of the month to begin backup from 
the drop-down menu. 

 

Continuous Continuously backup files. 

2. Click on Start to create a backup job. 

Once the job is created, Backup Now 5 Scheduler will execute the job based on your schedule settings.  
Notes: 

• The Track-At-Once (TAO) writing method is generally faster than Packet-Writing. However, Packet-Writing 
is more reliable on slower systems or older CD burners. Backup Now 5 selects the recommended writing 
method based on your CD/DVD recorder. It is highly recommended that you only select the TAO writing 
method when your drive(s) support one of the buffer underrun protection technologies such as 
BurnProof™.  
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Continuous Backup 
 
Step 1: What to backup? 
 

Ä Step 1:  What to backup? 
NOTE:  Continuous Backup is only available on Backup Now Shadow Edition and Advance Edition. 

1. Click on the "Backup" icon from the toolbar or select "Backup" from the View menu. 

2. Select the "Continuous" tab and click the Step 1 button on the left-hand side of the main window. 

3. Select one of the following backup options: 

Basic Once you have selected the folders and files, you can set up the Filters if you want to include or 
exclude certain file extensions from the backup job.  

Ä  To set up the File Type Filters: 

1. Backup Now 5 backs up all file types by default.  If you want to include or exclude a certain 
file type, follow the 2 steps below: 

• Step 1:  Select or type in file type (Audio, Picture, Video, Document, Custom types) 
• Step 2:  Select Include or Exclude 

Note: 
Ñ  You can select to include certain file extensions or exclude certain file extensions, but 

not both at the same time. 
Ñ  The Include filter will back up only the files with the file extension(s) specified, whereas 

the Exclude filter will back up all files except for those with the extension(s) specified. 

2. If you want to manually type the file extensions, select “Custom types (*.exe;*.jpg)”. This will 
enable you to input the file extensions into the text box.   

To Input File Extensions Manually: 
• Begin by entering a star (*) and a ‘period’ (.) followed by the file extension code 

(Example:  To enter a JPEG file, you enter *.jpeg) 
• You can enter more than one file extension by separating each of them with a semicolon 

(;). 
• A caution dialog box will remind you to begin with the star (*) and the period (.) if you 

forget to enter them on the text box. 
3. Click OK to save changes. 

Advanced Click on the checkbox next to the files you want to backup on the Collapsible Tree. 

4. Click the Step 2 button to select the destination of the backup file. 
 
 

 

 
 
Step 2: Where to backup? 

Ä Step 2:  Where to backup? 
1. Click on the "Browse" button and select the folder where your backup will reside. 

2. Select one of the following options regarding the number of previous file versions to save: 
• Save all previous file versions 

Store the previous version on the backup destination when you make changes to a file. 
• Save a limited number of previous file versions 

Store the specified number of previous file versions on the backup destination when you make 
changes to a file. Enter a specified number on the textbox. 
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• Do not save any previous file versions 
Do not store any of the previous file versions on the backup destination when you make changes to 
a file. 

3. Name the backup job on the Job Name textbox or click on "Edit" for the following options: 
On the Dialog window, select one of the following options and click on OK to continue. 
• Set default file names for backups 

Your default file name will consist of a Job Name, Date, and Time.  Use the drop-down menu to 
select the arrangement of your default file name. 

• Type a custom backup file name 
Enter the backup file name on the backup file name textbox. 

4. Click on Step 3 to proceed. 
 
 

 
Step 3: When to backup? 
 

Ä Step 3:  When to backup? 
1. Select one of the following schedule options: 

Now Backup files now. 

Later Backup files at a later time only. Enter the start time and set the specific month, day, and year to 
begin backup. 

 

Hourly Backup files hourly.  Enter the start time and set the interval in hours and minutes to begin 
backup. 

 

Daily Backup files daily. Enter the start time and select the days to begin backup. 

 

Weekly Backup files weekly. Enter the start time and select the day to begin backup from the drop-down 
menu. 

 

Monthly Backup files monthly.  Enter the start time and select a day from the month to begin backup from 
the drop-down menu. 

 

Continuous Continuously backup files. 

2. Click on "Start" to create a backup job. 
 
 

 
Drive Based Backup 
 
Step 1: What to backup? 
 

Ä Step 1:   What to backup? 
NOTE:  Drive Based Backup is only available on Backup Now Image Edition and Advance Edition. 
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1. Click on the "Backup" icon from the toolbar or select "Backup" from the View menu. 

2. Select the "Drive Based Backup" tab and click the Step 1 button on the left-hand side of the main 
window. 

3. Select the drives you want to backup and choose one of the following options: 
• Create Drive Image Backup 
• Create Emergency Recovery CD/DVD 

4. Click the Step 2 button to select where to backup. 
 
 

 
Step 2: Where to backup? 
 

Ä Step 2:   Where to backup? 

1. Select one of the following destination for your backup files from the drop-down window: (a) Hard disc 
drives,  (b) Network drives, (c) Device with removable storage, and (d) FTP server. 
• If you have chosen to backup to a remote FTP server, enter the correct FTP server information. 
• Select more than one drive to hold your backup set (drive spanning) if your destination does not 

have enough space. 
2. Change the corresponding backup filename if desired. 

Drive Image Backup File Extensions 

.NPS The .NPS (partition set) file is your drive image backup job data file index. It holds the description of 
the .NPF files.  Each backup job creates a .NPS file accompanied by one or more .NPF files. 

.NPF The .NPF (partition file) files hold your drive image backup file. One .NPF file for every logical drive. For 
example, if you backup three drives (C:\, D:\ and E:\), you will have three .NPF files created. 

3. Click the Step 3 button to select when to backup files. 
 
 

 
Step 3: When to backup? 
 

Ä Step 3:   When to backup? 
1. Select one of the following schedule options: 

Now Backup files now. 

Later Backup files at a later time only. Enter the start time and set the specific month, day, and year 
to begin backup. 

 

Daily Backup files daily. Enter the start time and select the days to begin backup. 

 

Weekly Backup files weekly. Enter the start time and select the day to begin backup from the 
drop-down menu. 

 

Monthly Backup files monthly.  Enter the start time and select the day of the month to begin backup 
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from the drop-down menu. 

 

Continuous Continuously backup files. 

2. Click on "Start" to create backup job. 
 
 

 
Restore 
 
Step 1: What to restore? 
 

The Restore feature allows you to control what, where, and how Backup Now 5 will do a restore operation from the 
Restore Options dialog. 

Ä Step 1:   What to restore? 
1. Click on the "Restore" icon from the toolbar or select "Restore" from the View menu. 

2. Click the Step 1 button on the left-hand side of the main window. 

3. Load the Collapsible Tree from the drop-down menu and select a specific backup file type to restore.  

• If you select a FTP backup set, enter the host name/IP address, port number, user name and 
password on the pop-up window to connect. 

4. Click on the "Open" button and select the folders or files you wish to restore. 

5. Click the Step 2 button to select the destination or where you want to restore the backup files. 
 
 

 
Step 2: Where to restore? 
 

Ä Step 2:   Where to restore? 
1. Select to restore at its Original location or select Other location and specify the destination. 

2. Click the Step 3 button to select how to restore your backup files. 
 
 

 
Step 3: How to restore? 
 

Ä Step 3:  How to restore  
1. Select one of the following restore options: 

• Never replace a file with its backup copy 
• Replace a file only if its backup copy has a newer file date and time 
• Always replace a file with its backup copy 

2. Select one of the following schedule options: 

Now Restore backup copy now 

Later Restore backup copy at a later time. Enter the restore start time and date. 

 

3. Once you have selected the files to be restored, simply click on the Start button to start the restore 
process.  

Note: 
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Ñ  The Collapsible Tree in Step 1 displays the location (disc number) of every file in the backup set. Please 
insert the correct disc before starting the restore process. In cases where you are restoring multiple files 
from multiple discs, Backup Now 5 will prompt you for each disc as required. 

 
 

 
Restoring files using Find Files 
 

You can search a backup image for a specific file using the Find Files. Are you missing a file that you know you had 
previously backed up?  

Ä To locate and restore a file with Find Files: 
1. In Restore mode, load the Collapsible Tree from the drop-down menu and select a specific backup file, 

or an FTP server. 

2. Select Find Files… item from the Edit Menu. 

3. Enter the name of the file you want to search in the "Named:" edit box. 
Note: 
Ñ  The find files feature supports standard wildcard searches such as *.doc to locate all Word 

documents in a backup or selected catalog. 

4. From the list of found files, select the files you wish to restore. 

5. Select the location of the restore, and set the restore options. 

6. Click the Start button to start the restore operation. 
Note: 
Ñ  The Find Files dialog displays the location (disc number) of every file that meets your Find criteria. 

Please insert the correct disc before starting the restore process. In cases where you are restoring 
multiple files from multiple discs, Backup Now 5 will prompt you for each disc as required. 

 
 

 
Compare 
 
Step 1: What to compare? 
 

You can compare original files to the backed up version of that file using the compare operation. File level 
compares can be run from a specific backup image or the catalog. You select the compare operation by clicking the 
compare icon on the main toolbar.  

Ä Step 1:  What to compare? 
1. Click on the "Compare" icon from the toolbar or select "Compare" from the View menu. 

2. Click the Step 1 button on the left-hand side of the main window. 

3. Load the Collapsible Tree by clicking on the "Browse" button and select a specific backup file, or an FTP 
server.  

4. Click on the "Open" button and select the folders or files you wish to compare. 

5. Click the Step 2 button to select the destination or where the files are you want to compare with the 
backup files selected in Step 1. 

 
 

 
Step 2: Where to compare? 
 

Ä Step 2:  Where to compare? 
1. Select the Compare destination at its original location or click the "Browse" button to select an alternate 

location.  
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2. Once you have selected the files to be compared, simply click on the Start button to start the compare 
process. 

 
 

 
Migrate 
 
Step 1: How to migrate? 
 

The Migrate feature allows you to select how, what, and where to migrate data files. 

Ä Step 1:  How to migrate? 
1. Click on the "Migrate" icon from the toolbar or select "Migrate" from the View menu 
2. Select one of the following migrate options on Step 1: 

• Standard mode (Running as regular application) 
• Low priority (Only runs when your computer is not busy) 

This options allows you to start the task if the computer has been idle for an entered amount of 
minutes. If the computer has not been idle for that long, it will automatically retry for up to an entered 
amount of minutes.  You can also move a slider to select a priority setting for this job. 

3. Select one of the following migrate schedule options: 

Now Migrate files now. 

Later Migrate files at a later time only. Enter the start time and set the specific month, day, and year to 
begin migrate. 

 

Hourly Migrate files hourly.  Enter the start time and set the interval in hours and minutes to begin migrate. 

 

Daily Migrate files daily. Enter the start time and select the days to begin migrate. 

 

Weekly Migrate files weekly. Enter the start time and select the day to begin migrate from the drop-down 
menu. 

 

Monthly Migrate files monthly.  Enter the start time and select the day of the month to begin migrate from the 
drop-down menu. 

 

4. Click the Step 2 button to select what files or folders to migrate. 
 
 

 
Step 2: What to migrate? 
 

Ä Step 2:  What to migrate? 
1. Select the checkbox next to folders or files you wish to migrate. 

2. Click the Step 3 button to select the migrate destination. 
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Step 3: Where to migrate? 
 

Ä Step 3:  Where to migrate? 
1. Choose the destination drive from the drop-down menu. 

2. Select the checkbox next to the folder or files you wish to migrate. 

3. Click on the Start button to start the migrate process. 
 
 

 
Additional Features 
 
Blu-ray Compatibility 
 
Introduction to Blu-ray Disc 
 

Backup Now 5 is now compatible with Blu-ray Disc! 

Blu-ray Disc is a technology platform that has a large storing capacity with a high-speed data transfer rate in an 
easy-to-use optical disc format.  There are currently four kinds of Blu-ray recordable/writable media: 

• Single-layer 25 GB:  BD-R, BD-RE 
• Double-layer 50 GB: BD-R DL, BD-RE DL 

A BD-R disc can be recorded once and would be ideal for archiving, storing, and distributing data and video 
material.  While a BD-R cannot be erased, a BD-RE disc can be recorded multiple times and offers extensive 
editing functionality and is ideal for making sequential backups or recording video. 

With Backup Now 5, you can manage your important data on your Blu-ray Disc more efficiently.Using Blu-ray discs 
with Backup Now 5 requires the use of discs and special drives developed for the Blu-ray function. 

SYSTEM REQUIREMENTS: 
• Hardware:  Blu-ray Disc Recorders 
• Disc: BD-R, BD-RE, BD-R DL, BD-RE DL 

 
 

 

Working with Blu-ray Disc 
 

Ä How to view information about your Blu-ray Disc: 

1. Go to "Utilities" tab and select Disc Information... to open the Disc Info & Tools window. 
2. On the Disc Info & Tools window, you can view information about your Blu-ray disc and also choose to 

"Refresh" or "Erase" your disc. 
3. Click on the "Close" button to exit. 

Ä How to backup files to your Blu-ray Disc: 

1.   After you have selected th files and folders to backup on EasySteps 1, go to EasySteps 2. 

2.   On the Backup destination section, select "Backup to CD/DVD Writer" and insert the Blu-ray disc on your 
drive. 

3.   After inserting the Blu-ray disc, you can change the backup name under the Backup file name textbox. 

4.   Select the desired writing speed and write method, then go to EasySteps 3 to continue. 

5.   On the How to backup window, select your backup preference and desired options. 

6.   Click on the "Start" button to start backup. 
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Ä How to erase your Blu-ray Disc: 

1.   Go to "Utilities" tab menu and select the Erase Disc icon to open the Erase Disc window. 

2.   On the Erase Disc window, you can view information about your Blu-ray disc. 

3.   Select the drive where your Blu-ray disc is located and choose either "Quick" or "Full" on the Type of erase 
section. 

4.   Click on the "Start" button to start erasing the disc. 
 
 

 
Job Management 
 
Job Reports 
 

The Job Report lists the job name, status, source, destination, and date of the last activity based on your 
backup method. 

 

Ä To view a Job Report:  
1. Click on the “Job” icon from the toolbar or select "Jobs" from the View menu. 
2.   On the Jobs window, select one of the following methods used to view the current jobs listed: 

• Standard Backup/Restore – Standard Backup and Restore jobs are listed here. 
• Continuous Backup – Continuous backup jobs are listed here. 
• Image Backup/Restore – Image backup and restore jobs are listed here. 
• Migration – Migration jobs are listed here. 

 
 

 
Managing Jobs 
 

 

Ä On the Job Management window, right-click on the job you want to manage on the left panel and 
select one of the following options: 

• Refresh Job - Refresh current list. 
• Run Job - Run backup job now. 
• Stop Job - Stop current backup job now. 
• Delete Job - Delete backup job. 
• Modify Job - Modify you backup configuration. 

 
 

 

 
 
Utilities 
 
Utility Options Overview 
 

The Utilities options allow you to view and change a variety of information and settings on your system, 
drives, network and FTP server.  To access the Utilities Options, click on the “Utilities” icon on the 
toolbar or select “Utilities” from the View menu.  

Topic Highlights: 
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• About your system – System and disk capacity information. 
• About your drives – Drive properties, Disc Info & tools, Erasing a CD-RW Disc, Comparing two file 

folders. 
• About your network – Network and protocol information. 

 
 

 
About your system 
 

Ä System Information 
The System Information dialog displays the following information: 

Hardware 
Resources 

Resource and device information about the following: Conflicts/Sharing, DMA, 
Forced Hardware, I/O, IRQs, and Memory. 

Components Item, value and various information about your multimedia drives, input, network, 
ports, storage, printing, USB and lots more. 

Software 
Environment 

System Drivers, Signed Drives, Environmental Variables, Print Jobs, Network 
Connections, and lots more. 

Internet Settings File Versions, Connectivity, Cache, Content, and Security. 

Applications Various system applications. 

Ä Drive Information 
Select the drive from the drop-down menu to view the capacity, file system and space distribution as shown 
below: 

 
 
 

 
About your network 
 

Ä Network Information 
The Network Information dialog displays the following network configuration: 

Network 
Description 

Network specs and information. 

Adapter Name Also known as a "network interface card" (NIC), the network adapter controls the 
transmission and receiving of data at the data link level (layers 1 and 2 of the OSI 
model) 

Physical Address Displays the physical address of your network. 

IP Address The IP is the address of a device attached to an IP network (TCP/IP network). 

Default Gateway The default gateway is the router used to forward all traffic that is not addressed to a 
station within the local network or local subnet. Its primary purpose in most SOHO 
applications (homes and small businesses) is to direct Internet traffic from the local 
network to the cable or DSL modem, which connects to the Internet service provider 
(ISP). 

DHCP Dynamic Host Configuration Protocol  (DHCP) is the software that automatically 
assigns temporary IP addresses to client stations logging onto an IP network.  
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Primary Wins 
Server 

Displays primary Windows network server. 

Ä Protocol Information 
The Protocol Information dialog displays the network's active TCP/UDP, its local address, foreign address, and 
status. 

• TCP (Transmission Control Protocol) - The reliable transport protocol within the TCP/IP protocol suite. 
TCP ensures that all data arrive accurately and 100% intact at the other end. 

• UDP (User Datagram Protocol) - A protocol within the TCP/IP protocol suite that is used in place of TCP 
when a reliable delivery is not required. UDP is widely used for streaming audio and video, voice over IP 
(VoIP) and videoconferencing, because there is no time to retransmit erroneous or dropped packets. 

 
 

 
About your drives 
 
Drive Properties 
 

The Drive Properties dialog displays the read and write capabilities of the selected drive. Clicking on the Drive 
Properties icon on the Utilities Menu will display the Drive Properties for the selected drive. 

Write Capabilities: 
The write capabilities section indicates the supported write speed and indicates if the selected drive supports 
various features. 

• Dynamic Drive Support – "On" indicates that this drive was not in the Drive Support database and was 
detected by Dynamic Drive Support™. 

• CD Recordable – This drive writes to CD-R media at these speeds. 
• CD Rewritable – This drive writes to CD-RW media at these speeds. 
• DVD Recordable – This drive writes to CD-R media at these speeds. 
• DVD Rewritable – This drive writes to CD-RW media at these speeds. 
• Buffer Underrun Error Protection – This drive supports Buffer Underrun Error Protection. 
• Disc-At-Once – This drive supports the Disc-At-Once writing method. 
• Session-At-Once – This drive supports the Session-At-Once writing method. 
• Packet Writing – This drive supports packet-writing. 

Read Capabilities: 
The read capabilities section indicates the supported write speed and indicates if the selected drive supports 
various features. 

• Max Speed – This drive will read at this speed. 
• Read CD-RW (Multi-read) – This drive supports multi-read for CD-RW media. 

 
 

 
Disc Info & Tools 
 

You may wish to check information about a disc before you decide to import any session from the CD-ROM disc. 
To do this, choose Disc Information icon under the Utilities menu. The "Disc Info & Tools" dialog box will appear. 

This box contains informational fields about the disc, including its Disc Type, Capacity, Free Space. Status, and 
other details as shown below: 

Disc Type 
The disc type can be one of the following: (1) CD-DA or CD-ROM disc; (2) CD-I disc; (3) CD-ROM XA disc. 
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Disc Status 
• Blank Disc: a blank piece of media is in the selected drive.  
• Recordable Disc: not a blank disc but you can still use this disc to record. That means the disc has not 

been finalized yet. 
• Unrecordable Disc: either a conventional CD/DVD or Disc has been finalized. You cannot use this disc to 

record. 

Re-Writable 
This field indicates the total recordable capacity of the disc, as expressed in the "minutes: seconds: frames" 
format. If you insert a disc, this field will show you the exact capacity of the data stored on the disc. 

Used Space 
This field shows the amount of used space on the disc, as expressed in "minutes: seconds: frames" and 
megabytes (MB). 

Free Space 
This field shows the free and available space on the disc, as expressed in "minutes: seconds: frames" and 
megabytes (MB). If you insert a finalized or silver disc, this field will be zero, indicating no free space. 

Buttons  

• Refresh: When you insert another CD, click this button to display updated information about the new CD. 
Or, when you want to make sure that the contents of the currently inserted disc are correctly displayed, 
click on the Refresh button. 

• Erase: The erase button will be enabled if the disc in the selected drive is a erasable. You can erase the 
disc by clicking this button.  

• Close Session: If there are sessions that have remained open, when you highlight the open session, the 
Close Session button will be enabled. You can click it to close the selected session. 

• Close: Closes the Disc Info & Tools dialog when clicked. 
 
 

 
Erasing a CD-RW Disc 
 

You can erase your CD-RW media directly from the Backup Now 5 Tools Menu. You can choose either a Quick 
Erase or Full Erase. The quick erase function overwrites the existing table of contents, thus reducing the time it 
takes to erase a CD-RW disc to just a few minutes. The full erase function erases all data on the disc and takes a 
considerably longer amount of time to complete. A full erase however restores the CD-RW media to a more reliable 
state. 

Ä  To erase a CD-RW disc: 

1. Select the Erase CD-RW disc item from the Utilities Menu. 

2. Select the CD-RW drive that contains the CD-RW media that you would like to erase from the 
CD-RW Drive list. 

3. Select either Quick or Full for the Type of erase option. For reliability reasons, it is recommended that 
you choose the Full erase option. 

4. Click Start to begin erasing. 
 
 

Comparing Two File Folders 
 

It is possible to compare the contents of two folders on your system using Backup Now 5’s Compare Files function. 
This utility is useful, for example, when you want to compare a backup copy to its original. Otherwise, this is a 
general tool for comparing the contents of similar directories. 

Ä  To compare the contents of two folders: 

1. Select Compare from the View Menu.  
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2. Enter the locations of folders you wish to compare in each text field. If you don’t know the location of 
the folder, click on the browse button next to the text fields to search for the desired folders. 

3. Click on OK. 

The comparison result will show files that exist in one folder but not the other, files that are identical, and files that 
are different (i.e. "not compared"). 

 
 

 
Reports 
 
Completion Reports 
 

Backup Now 5 generates a completion report at the end of every backup, restore, or compare operation. These 
reports can contain a list of all files selected for a given operation and the status of the operation. You will want to 
view these reports to be sure that an operation was completed successfully. A report may be viewed upon the 
completion of an operation. All reports are saved in the Backup Now 5 Reports folder where they can be viewed 
later if necessary. 

 
 

 
Backup Reports 
 

Ä To view a Backup Report:  
1. On the backup window, click on the Report button on the left panel. 

2. Backup Now 5 displays the Backup Report dialog box. 

3. Select the report you would like to view from the list of reports. 
 
 

 
Restore Reports 
 

Ä To view a Restore Report:  
1. On the restore window, click on the Report button on the left panel. 

2. Backup Now 5 displays the Restore Report dialog box. 

3. Select the report you would like to view from the list of reports. 
 
 

 
Deleting Reports 
 

Ä To Delete Reports:  
• On the Reports window, right-click on the file you want to delete on the left panel and select "Delete" from 

the drop-down menu. 
 
 

 
Options 
 
Setting Backup, Restore and Migrate Options 
 

You can control how Backup Now 5 performs backup, restore and migrate operations. You can click the Options 
button on either the Backup, Restore or Migrate function. 

Ä  To modify the Backup/Restore/Migrate options: 

1. Open the backup, restore or migrate options dialog. 
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2. Click on the appropriate tab for the options you wish to change. 

3. Select the desired option settings. 

4. Click OK to save your changes and close the selected options dialog box. 

Note: 

Ñ  Clicking the Cancel button will close the options dialog box without saving your changes. 
 
 

 
Open File Manager Option 
 

The Open File Manager option is only available on Backup Now 5 Advance Edition. 

Ä  To enable the Open File Manager feature: 

1. On Continuous or File based backup tab, click on the Options button. 

2. Select the Advance tab and click on the "Backup open file using open file manager" checkbox. 

3. Click OK to finish. 

This feature allows you to keep some applications such as SQL, Exchange, and Outlook active while also being 
able to backup files that would have been locked or restricted with these applications running. 

 
 

 
Backup Options 
 
General Tab 
 

The General Tab contains settings to select the compression method for the backup file and provide a media label. 
You may also specify whether you want Backup Now 5 to perform a comparison of the backed up file with the 
original when the backup file is created.  

Compare/Verify backup file… 
Compares the contents of the original files to the data in the backup set. The verify process happens after a 
CD/DVD is full and before spanning to the next disc (if necessary). The backup file is opened and the data is 
decompressed and then compared to the contents of the original file. Verify can add several minutes to the total 
backup time. Uncheck this box to skip the verification process. 

Tone after the backup finished 
Backup Now 5 will sound an alarm tone (beeping) at the completion of a backup job when this box is checked. 

No data compression 
Disabling data compression requires the least amount of time to complete the backup operation. It requires the 
most space on the destination disc due to larger backup files. 

Data compression 
Normal data compression uses less space for the backup than no compression. It is also faster than using 
maximal compression. 

Use multiple drives to backup (Drive Spanning) 
The ability to continue a backup or restore operation over multiple CD/DVD drives. Drive Spanning can let you 
backup to multiple drives before asking for additional media. This can be helpful in cases where a larger amount 
of data must be backed up using scheduled, unattended, backups. 

• 640 MB (Normal CD-ROM Size) 
• 1 GB 
• 2 GB 
• Maximum file size supported by the file system. 

NOTE:  The Drive Spanning feature is only available on Drive based Backup. 
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Report all files that were backed up 
Select this option to report all files that were backed up. 

Turn off Outlook before doing backup 
Select this option to turn off Outlook before doing backup. 

After Backup Options 
Select on of the following backup options: 
• Take No Action 
• Shut down 
• Log-off 
• Hibernate 
• Stand-by 

 
 

 
Media Tab 
 

The options on the Media Tab are used to select if a previous backup file is to be overwritten with the current one or 
the current backup file will be appended to the destination disc. In case of CD-R media, backup files are always 
appended to the end. 

Eject the media after backup is finished 
This option tells Backup Now 5 to eject the media once the backup job has completed. This is the default setting 
for this option. You may wish to disable this option in cases where you are running unattended backups and 
appending your backup jobs to the existing media. 

Append this backup to the media 
This option will let you keep the previous backup file along with the one currently being created. The backup will 
be written in addition to the previous backup, without overwriting it. 

Overwrite the media with this backup 
This option will let you overwrite the previous backup file with the one currently being created. This is convenient 
for scheduled backups, which will use the same media for backup, without having to erase the media manually. 

Prompt me for options 
Selecting this option causes Backup Now 5 to prompt you for either the append or overwrite option whenever 
you create your backup. 

Speed 
Select your write speed preference from the drop-down menu. 

Write Method 
Select one of the following write method: 

• Tract-At-Once (TAO) - To record all  the data on a CD-R disc one track at a time.  The laser is turned off 
after each track, which produces a two-second gap between songs.   

• Packet Writing  -  Packet writing allows smaller blocks of data to be written.  Fixed-length packets are 
commonly used with CD-RWs to make them perform similar to a hard disk and allow small files to be 
deleted.  Variable-length packets are used to save space and are more suitable for recording CD-Rs. 

Name of media 
Enter the name of your media on the designated textbox. 

Media Interface 
Select one of the following media interface: 

• IDE (Integrated Drive Electronics) - A hardware interface widely used to connect hard disks, optical 
disks and tape drives to a PC. Compared to the SCSI interface, IDE has been the more economical choice. 

• SCSI (Small Computer System Interface) - A hardware interface that allows for the connection of up to 
15 peripheral devices to a single PCI board called "SCSI host adapter" that plugs into the mother board. It 
is widely used in servers, mainframes and storage area networks (SANs). 

Notes: 
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Ñ  The Overwrite function is not available when you are using recordable (not rewritable) media for your backup 
job. For CD-R, DVD-R & DVD+R media, the "Append this backup to the media" will be used automatically. 

Ñ  Overwriting a rewritable CD or DVD will erase all files on the disc and not just overwrite the backup set. On a 
hard drive, the overwrite option will delete the backup set (if it exists) and then create new one with the same 
name. 

 
 

 
My Profile Tab 
 

The My Profile Tab specifies the folders to back up.  

Ä  To add and remove specific folders on the My Profile backup list: 

1. Use one of the following options under the My Profile Tab: 

• To add folders - Select and highlight a folder from the My Computer collapsible tree and click the 
"Add" button.  

• To remove folders - Select and highlight a folder from the My Profile list and click the "Remove" 
button. 

2. Click on the "OK" button to save the changes. 
 
 

 
Filter Tab 
 

Once you have selected the folders and files, you can set up the Filters if you want to include or exclude certain file 
extensions from the backup job.  

Ä  To set up the File Type Filters: 

1. Backup Now 5 backs up all file types by default.  If you want to include or exclude a certain file type, 
follow the 2 steps below: 

• Step 1:  Select or type in file type (Audio, Picture, Video, Document, Custom types) 
• Step 2:  Select Include or Exclude 

Note: 

Ñ  You can select to include certain file extensions or exclude certain file extensions, but not both at 
the same time. 

Ñ  The Include filter will back up only the files with the file extension(s) specified, whereas the 
Exclude filter will back up all files except for those with the extension(s) specified. 

2. If you want to manually type the file extensions, select “Custom types (*.exe;*.jpg)”. This will enable 
you to input the file extensions into the text box.   

To Input File Extensions Manually: 
• Begin by entering a star (*) and a ‘period’ (.) followed by the file extension code (Example:  

To enter a JPEG file, you enter *.jpeg) 
• You can enter more than one file extension by separating each of them with a semicolon 

(;). 
• A caution dialog box will remind you to begin with the star (*) and the period (.) if you forget 

to enter them on the text box. 
3. Click OK to save changes. 

Note: 

Ñ  The "Restore Defaults" button will clear any available file types the user has included or excluded. 
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Security Tab 
 

Options on the Security Tab determine if your backup files will be password protected. 

Enable password protection 
Selecting this option will add password protection to the file level or drive image backup. A password-protected 
backup can only be restored by entering the correct password. 

Password  
Enter the password to be used for your backup file. 

Reenter password  
Verify your desired password. 

Enable Data Encryption and Use Password as Secret Key 
Enabling encryption on your backup adds an extra layer of security to your data. Selecting this option will 
encrypt any sensitive data in your backup file so that no one can read its contents. 

Encryption Key Size 
Encrypt your data using 128, 192, or 256-bit keys. A larger key offers increased security, but it will also 
increase the time needed to encrypt data. 

 
 

 
Notify Tab 
 

You can set your e-mail address on the Notify Tab.  

Ä How to set your e-mail address: 

1. Enter the following information on the Notify Tab: 

• From:  Correspondent e-mail. 
• To:  Recipient e-mail. 
• Cc:  Carbon copy. 

2. Click on "OK" to save changes. 
 
 

 
Path Tab 
 

The Path tab option is only available on Continuous backup. 

• Delete file on backup destination when the file is deleted on your PC. 
Allows you to automatically delete the backup file when the file is deleted on your PC. 

• Maintain full path of backup files and folder. 
Allows you to maintain the same full path of your backup files and folder when you restore. 

 
 

 

Advanced Tab 
 

The Advance tab options is only available on Continuous and File based backup. 

• Backup locked files using open file manager 
Enable NTI Open File Manager to access locked files to backup. 

• Create CD/DVD label with JewelCase Maker 
Enable JewelCase Maker to create customized CD/DVD labels. 
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User Account Tab 
 
The User Account Tab gives the user an option to change the user name and password. The job will run under this user 
name and password. A local administrative privileged account must be used to access the change.  
 

Username 
Enter the username with the local administrative privilege. 
 
Password 
Enter the password for the username. 
 
Test Connection 
This enables the user to test the account privilege. 

 
 

 
Restore Options 
 
Restore Options 
 

You can control how Backup Now 5 will do a restore operation from the Restore Options dialog.  

Ä  To open the Restore Options dialog: 

1. On the restore window, click on the Options button. 
 
 

 
Report Tab 
 

Options on the Report Tab determine the items included in the completion reports for all restore operations. 

Report all files that were restored 
This option, when selected, will include information about every file restored on your computer in the completion 
report. 

 
 

 
Migrate Options 
 
Migrate Options 
 

You can control how Backup Now 5 will do a migrate operation from the Migrate Options dialog.  

Ä  To open the Migrate Options dialog: 

1. On the migrate window, click on the Options button. 
 
 

 
Migrate Tab 
 

Options on the Migrate Tab determine if the original copy is kept or deleted when you migrate files. 

Ä  Select one of the following options on the Migrate tab: 

• Keep original copy - File will be migrated to selected destination and kept on the original location. 



26 

• Delete original copy - File will be migrated to selected destination and deleted on the original location. 
 
 

 
 
Media Tab 
 

The options on the Media Tab are used to select if a previous backup file is to be overwritten with the current one or 
the current backup file will be appended to the destination disc. In case of CD-R media, backup files are always 
appended to the end. 

Eject the media after backup is finished 
This option tells Backup Now 5 to eject the media once the backup job has completed. This is the default setting 
for this option. You may wish to disable this option in cases where you are running unattended backups and 
appending your backup jobs to the existing media. 

Append this backup to the media 
This option will let you keep the previous backup file along with the one currently being created. The backup will 
be written in addition to the previous backup, without overwriting it. 

Overwrite the media with this backup 
This option will let you overwrite the previous backup file with the one currently being created. This is convenient 
for scheduled backups, which will use the same media for backup, without having to erase the media manually. 

Prompt me for options 
Selecting this option causes Backup Now 5 to prompt you for either the append or overwrite option whenever 
you create your backup. 

Speed 
Select your write speed preference from the drop-down menu. 

Write Method 
Select one of the following write method: 

• Tract-At-Once (TAO) - To record all  the data on a CD-R disc one track at a time.  The laser is turned off 
after each track, which produces a two-second gap between songs.   

• Packet Writing  -  Packet writing allows smaller blocks of data to be written.  Fixed-length packets are 
commonly used with CD-RWs to make them perform similar to a hard disk and allow small files to be 
deleted.  Variable-length packets are used to save space and are more suitable for recording CD-Rs. 

Name of media 
Enter the name of your media on the designated textbox. 

Media Interface 
Select one of the following media interface: 

• IDE (Integrated Drive Electronics) - A hardware interface widely used to connect hard disks, optical 
disks and tape drives to a PC. Compared to the SCSI interface, IDE has been the more economical choice. 

• SCSI (Small Computer System Interface) - A hardware interface that allows for the connection of up to 
15 peripheral devices to a single PCI board called "SCSI host adapter" that plugs into the mother board. It 
is widely used in servers, mainframes and storage area networks (SANs). 

Notes: 
Ñ  The Overwrite function is not available when you are using recordable (not rewritable) media for your backup 

job. For CD-R, DVD-R & DVD+R media, the "Append this backup to the media" will be used automatically. 
Ñ  Overwriting a rewritable CD or DVD will erase all files on the disc and not just overwrite the backup set. On a 

hard drive, the overwrite option will delete the backup set (if it exists) and then create new one with the same 
name. 
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Technical Support 
 
Contacting Technical Support 
 

NewTech Infosystems (NTI) is an industry leading developer of powerful, feature-rich, and easy-to-use software for 
digital media and storage management.  NTI has developed and delivered innovative digital media and data 
backup solutions since being founded in 1993.  As a pioneer in the world of CD burning technologies and software, 
NTI released the world's first CD copy software in 1994.  Today, NTI's CD/DVD burning engine has an installed 
base of over 80 million users worldwide.  NTI also offers volume licensing and OEM products. 
 
For Technical Support & Assistance Contact:   

E-mail: Support@NTIus.com  
Phone: (949) 421-0712  
Website: www.NTIus.com 

 
 

 

 
NewTech Infosystems, Inc. 
9999 Muirlands 
Irvine, CA  92618 USA 
www.NTius.com 
Phone:  1(949) 421-0720   Fax:  1 (949) 421-0750 

Many different types of on-line help are available with Backup Now 5 within the specified applications. You can 
browse through the Backup Now 5 Help file to become familiar with all the features available within that application. 

You can also use context-sensitive help to display information about specific commands, dialog boxes, and other 
window elements. 

If you still experience problems using Backup Now 5 that this documentation cannot solve, please check our web 
site at www.ntius.com/support.asp for support. Help and information on the latest updates as well as an 
Technical Forum on Frequently Asked Questions (FAQs) can be found on our web site at 
http:\\forums.ntius.com/faq.asp 

Notes: 

Ñ  If your Backup Now 5 software came with your computer or CD Recorder, you will usually need to contact the 
support group of the provider of our software for support and updates for your software. You may visit our 
support site for general information and answers to FAQ's at your convenience. In most cases, our support 
team will be unable to assist you in this circumstance. We are sorry for any inconvenience or delays you may 
encounter. 

Ñ  You must be a registered user to get support for our software. You will be asked to register your software if you 
have not already done so. 

 

We are committed to your success! We hope to make your experience with Backup Now 5 the best possible by 
making available news and information, product updates and upgrades, Frequently Asked Questions and our 
Technical Support from the Internet. Our web site is at www.ntius.com. 

Company or Product News and Information 
Find out the latest about what we are doing at www.ntius.com/news.asp or any of our world-class products at 
www.ntius.com/products.asp. Learn about the latest features or supported drives for Backup Now 5 You can 
even download a trial version of any of our products directly from our web site giving you the easiest way to 
give our software a test drive before you buy. 

Frequently Asked Questions (FAQ) 
You can browse the latest information and commonly asked questions about Backup Now 5 from our web site 
at www.ntius.com/faq.asp. Find out what questions other Backup Now 5 users had about it. Get quick 
answers to the most commonly asked questions. 

Updating the Supported Drive Database 
We frequently add support to new drives to our drive support database. You can use our Live Update feature to 
download and automatically install the latest drive support database on your system. Click the Live Update 
item on the Tools Menu to use Live Update to download the latest database from our servers.  

Note: You must be online to use the Live Update feature. 

mailto:Support@NTIus.com
http://www.NTIus.com
http://www.NTius.com
http://www.ntius.com/support.asp
http://www.ntius.com
http://www.ntius.com/news.asp
http://www.ntius.com/products.asp
http://www.ntius.com/faq.asp
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Updating your Backup Now 5 Software 
From time to time, we release product updates and upgrades from our web site. Product updates generally 
contain patches and other corrections to the Backup Now 5 software and are available for registered users to 
download for free. Upgrades involve major product enhancements along with patches to reported problems. 
They will also be available for download but may involve a nominal fee.  

Updates can be installed by executing the downloaded file. All updated files and patches will be applied to your 
Backup Now 5 software automatically! It is highly recommended that you download and install any updates 
prior to contacting our Technical Support Department. 

Visit our web site at www.ntius.com/download.asp for the latest updates for all our products! 

THANK YOU FOR YOUR COOPERATION! 
 
 

 
Installing & Uninstalling Backup Now 5 
 
Installing Backup Now 5 
 

To install Backup Now 5® you will need approximately 24-200 MB of free hard disk space depending on the edition. 
An automated SETUP program is provided to guide you through the installation. The default target directory (the 
directory where Backup Now 5 resides), is "C:\Program Files\NewTech Infosystems\NTI Backup Now 5". The 
setup program will walk you through the installation process. 

Ä  To install Backup Now 5: 

1. Insert the Backup Now 5 CD into the appropriate drive.  

2. An install screen is displayed automatically by Windows. If you do not see this screen then click Run 
from the Start button on the Taskbar and in the dialog box type: 

D:\install.exe 

Note: 

Ñ  Where "D" is the drive letter of the CD-ROM drive which contains the Backup Now 5 ® 
CD. The drive letter may be different depending on your system configuration. 

3. Click OK to execute the Setup program. 

4. On the Welcome panel, click on the Next button. 

5. Read the END-USER LICENSE AGREEMENT FOR SOFTWARE and click the Yes button if you 
accept the terms of the license agreement and wish to continue with the installation of the Backup 
Now 5 software.  

6. Enter your user information and the product serial number (if required) and click Next. 

7. Select the installation directory from the Choose Destination Location dialog and click the Next 
button. Click the Browse button to select a different installation directory if desired. 

8. Enter the Program Folder where the Backup Now 5 icons will be added and click Next. 

9. Backup Now 5® will now be installed in the target directory. Backup Now 5 program group with the 
appropriate shortcuts will be added to the Start menu. 

10. You will be asked to restart your computer. The Setup Complete dialog will let you reboot now or 
later. It is recommended to select the "Yes, I want to restart my computer now." option and Click the 
Finish button and reboot your computer. 

Notes: 

Ñ  You must have Administrator Rights to install Backup Now 5® on machines running Windows 2000/XP. 
 
 

 

http://www.ntius.com/download.asp
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Uninstalling Backup Now 5 
 

You can remove the Backup Now 5 software from your system from the Windows Add/Remove Programs utility. 

Ä  To uninstall the Backup Now 5  software: 

1. Run the Control Panel application from the Start -> Settings menu. 

2. Double-click the Add/Remove Programs icon. 

3. From the Install/Uninstall Tab, select Backup Now 5 ® from the list of programs installed on your 
computer. 

4. Click Add/Remove… 

5. Click Yes to confirm the removal operation. 
 
 

 
System Requirements 
 

It is important that your system meet the above requirements. If you have questions, please contact us for further 
information. Please check the following system requirements before installing Backup Now 5 

Hardware Requirements 
ü IBM PC or compatibles Pentium 90 or higher  
ü Minimum 128 MB RAM. (128 MB and above Recommended) Windows® 2000/XP/Vista Operating 

Systems may require at least 128 MB of RAM. 
ü Some features require an NTI-supported CD or DVD recorder. Please visit our web site at 

http://www.ntius.com/CertifiedCDRdrives.htm for the latest list of NTI-supported CD or DVD recorders. 

Software Requirements 
ü Microsoft Windows® 2000/XP/Vista. 

User Permissions 
ü For Windows® 2000 and Windows® XP, you must log in as a user with Administrator Rights to install 

Backup Now 5 
 
 

 
Error Messages 
 
The Log File 
 

Backup Now 5 will create a report file that may contain useful information to help you to trace and diagnose 
problems that can occur during recording.  Backup Now 5 will report all errors that have occurred in backup or 
restore process in these file(s). By default, all report files are located in the report Files directory found in the 
installation directory for your Backup Now 5 software. 

Each report file is a text file named after the backup job. They can be viewed in any text viewer like notepad.exe. 
You may be asked to provide a copy of one or more report files when working with the our Technical Support team. 
Please refer to the "Completion Reports" section. 

 
 

 

 
 

http://www.ntius.com/CertifiedCDRdrives.htm
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Error Messages 
 

Error: Failed to open file. 

Analysis: The backup image file (.nbf or .npf file) cannot be opened for reading. The file may have been damaged 
or incorrectly created. 

Solution: Use good brand-name media discs, as this error is often associated with bad media. If you use a CD-RW 
disc that has been written many times, we recommend that you do a full erase before using it again for 
backup. 

Error: Files not compared. 

Analysis: The backup copy stored in the backup image does not compare with its original file. 

Solution: The file has been modified since backup. This happens often to active system files or temporary files. 
Such cases are normal and no errors have occurred. 

Error: Insufficient Disk Space for restore. 

Analysis: There is not enough space in the target drive (partition) to restore the selected files or drive image. 

Solution: Choose a target drive with sufficient space. 

Error: Failed to prepare registry files for backup. 

Analysis: Failed to access the registry due to user permission restrictions, or registry files are damaged. 

Solution: In Windows 2000/XP, you must log on as a member of the Administrator’s group to be able to access the 
Registry. 

Error: Backup completed with skipped file(s). 

Analysis: Failed to open or read certain file(s), which is (are) skipped. 

Solution: Check your access rights to these files. Make sure these files are not in use or locked by other 
applications or users. In Windows 2000 and XP, we recommend that you log on as Administrator. 

Error: Restore completed with skipped file(s). 

Analysis: Failed to restore certain file(s) due to access restrictions. 

Solution: Check your access rights to these files. Make sure these files are not in use or locked by other 
applications or users. In Windows 2000 and XP, we recommend that you log on as Administrator. 

Error: Invalid Drive Image backup file 

Analysis: The drive image backup file on disc is either incorrectly created or damaged. 

Solution: Retry the backup to create a good drive image backup file. We recommend that you use good 
name-brand media, especially for CD-RW. 

Error: Data compression (or decompression) error. 

Analysis: Failed to read the compressed file on backup image file. The file may have been damaged. 

Solution: Retry the backup to create a good backup image file. We recommend that you use good name-brand 
media, especially for CD-RW. 

 
 

 
ASPI Manager Errors 
 

Error: An incompatible ASPI Manager is installed. 

Analysis: The SCSI card and ASPI Manager are not supported by Backup Now 5. 
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Solution: Make sure the ASPI Manager and SCSI card are supported by Backup Now 5. Please refer to the System 
Requirements in Chapter 1 in this manual. 

Error: No ASPI managers were found! 

Analysis: The ASPI device driver was not installed before you ran the program. 

Solution: Install the ASPI Manager. For instruction of how to install, please refer the documents provided by the 
SCSI card manufacturer. 

Error: ASPI for Windows failed to initialize. 

Analysis: ASPI for Windows did not properly load/initialize in memory. This may be caused by a lack of system 
resources and/or mismatched ASPI file version(s). 

Solution: Make sure the CD Recorder is connected to the PC and the power is on. Exit Windows and reboot the 
system. Then try it again. You may be required to re-install the ASPI device driver files if this error is a 
recurring problem. 

 
 

 
CD-ROM Drive & CD Recorder Errors 
 

Error: No supported CD Recorder found. 

Analysis: Either your CD-R/RW drive is not yet supported by your current version of Backup Now 5, or your drive is 
not installed correctly. 

Solution: Check our web site at www.ntius.com for drive support information. Make sure your drive is properly 
installed and connected. 

 
 

 
Memory & Hard Disk Space Errors 
 

Error: Out of memory. 

Analysis: There is not enough memory. 

Solution: Close other applications and try again. If it still can not be solved, reboot your system, and try again. 

Error: Fatal memory lost. 

Analysis: This is a memory management error. 

Solution: Close all the applications, reboot your system, and try again. 
 
 

 
Windows Errors 
 

Error: Cannot set timer. 

Analysis: Unable to set the timer which is a Windows resource. 

Solution: Close other applications and try again. 
 
 

 
 
 

http://www.ntius.com
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Glossary 
 
Drive Image Backup 
 

Drive Image backups are exact duplicates of a physical disk drive on your machine. Unlike file level backups, drive 
images bypass the file system and communicate directly with the physical disk drive. They can be written to either 
a CD/DVD/BD disc or another supported storage device. The best way to think of them is as clones. All data is 
replicated exactly as it exists on the drive being backed up. 

Drive image backups create an exact copy of the drive/partition being backed up. You can backup any drive that is 
installed on your computer system using drive image backups. A backup set can be saved on any CD/DVD/BD 
recorder on your computer or any device that provides drive letter access installed or connected to your system, 
including network hard disk. 

Restoring a drive using the Restore GUI is just as easy. It is important to remember however, that a drive image 
backup is a snapshot of the source drive at a particular moment in time. Restoring from this type of backup image 
is an all or nothing event. The destination drive will be restored exactly as it was when the backup image was 
created. All changes to that drive, made after the time that the backup image was created, will not be restored! 

Since drive image backups are copies of the actual disk partition or hard drive and work directly with the physical 
device, it is not possible to selectively restore specific files or folders to your system. You must use file level 
backups, found in a product like Backup Now 5 ® when you need to replace specific files or folders. 

 
 

 
Drive Spanning 
 

Drive spanning allows you to select multiple drives as targets for a backup job. You can select all CD/DVD/BD 
drives on your system, insert a piece of blank media in each drive and run your backup job. With drive spanning 
enabled, Backup Now 5 will use the first drive selected (in drive letter order) until that disc is full. Once the first drive 
is full, Backup Now 5 will automatically start writing to the next selected drive on the list. This process continues 
until all spanned drives are full and then Backup Now 5 will eject the tray from the first drive and prompt the user to 
insert another blank disc if necessary. 

 
 

 
Emergency Recovery Disc 
 

An Emergency Recovery Disc is a bootable CD/DVD/BD with containing an image of your system partition. It is 
used to recover your system partition and let you boot your computer into Windows. 

 
 

 
Hard Drive Spanning 
 

Hard drive spanning allows you to select multiple hard drives as targets for a backup job. You can select which hard 
drive partitions will store the backup files. With hard drive spanning enabled, Backup Now 5 will use the first drive 
selected (in drive letter order) until that disk is full. Once the first disk is full, Backup Now 5 will automatically start 
writing to the next selected drive on the list. This process continues until all spanned hard drives are full. 

 
 

 
Incremental Backup 
 
• Incremental backups record all changes made since the last backup. Only files that have been added or modified 

since the last backup are included in an incremental backup. This results in a reduced space requirement as 
saves media.  

• When you select the "New and changed files only" option, Backup Now 5 will backup all your changed files and 
clear the archive bit for you.  

• Restoring from an incremental backup requires that you restore the baseline backup file and then each 
subsequent incremental backup, in order, until you get to the desired target date. 
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Note: 
Ñ  The possibility exists that both backup jobs will run on one morning of every month. The baseline job is 

scheduled to run first and will backup all selected files on that date. The daily job runs second but will have very 
few, if any, files to backup and so it executes and exits quickly. 

 
 

 
Media Spanning 
 

The ability to continue a backup or restore operation over multiple CD/DVD/BDs. Media Spanning removes the 
limitations that the media capacity would otherwise place on the size of a single backup or restore operation. 

Media spanning is fully supported using Backup Now 5. Any backup file that exceeds the capacity of the existing 
media is split and carried over to the next CD. Extremely large backup files can be spanned across multiple CDs. 
Backup Now 5 handles this automatically and prompts you when a media change is required for both backup and 
restore operations. 

 
 

 
Recovery Diskette 
 

A Recovery Diskette is a modified version of the Startup Diskette. In addition to the files included by the operating 
system, it contains our restore.exe program. It is used when your system’s BIOS does not support booting from a 
CD device. 

 
 

 
Startup Diskette 
 

A Startup Diskette is a bootable diskette that is created by the Windows operating system. It can be used to boot 
your system to DOS and run some basic troubleshooting tools when you can not boot from your system hard drive. 

 
 

 
Drive Spanning 
 

Drive Spanning is enabled when you choose more than one CD/DVD/BD drives in the destination window.  You 
can use the up and down button to arrange the priority of each drive with the top listed being the first priority. 

Notes: 
Ñ  You can Save, Schedule or execute the backup job.  Your Drive Spanning options will be remembered 

each time you execute this backup job. 

Ñ  Backup Now 5 will start backing up your data to the first drive on the Selected Drive list. Once that disc is 
full, Backup Now 5 continues the backup job on the next drive on the list. This type of spanning continues 
until either the backup job has completed or all media in the selected drives is full. At this point, Backup 
Now 5 will start over at the top of the Selected Drive list and prompt you to insert a new piece of blank 
media in the first drive. 

 
 

 
Hard Drive Spanning 
 

Hard Drive Spanning is enabled when you choose more than two drives in the destination window. 

You can use the up and down buttons to set the priority of each drive. Once selected, the drives will be used in the 
order that they are found on the Selected Drives list. Backup Now 5 will write to first drive on the list and then switch 
to the second drive listed if and when the first drive is full. 
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Using Profile Backup 
 

Backup Now 5 allows you to make a profile backup – an easy way to backup your personal files such as Microsoft 
Outlook® and Outlook Express® email and data, your My Documents folder, the contents of your Desktop, your 
Favorites bookmarks, and installed Windows Fonts. Selecting which profile resources to backup is similar to 
selecting normal files. 

To select the Profile Backup mode: 

1. Make sure you are in Backup mode by clicking the Backup button on the toolbar. 

2. Click on the My Profile tab in the File Based Backup tab. A list of profile resources will appear. 

3. Expand a branch of the Collapsible Tree by clicking the + symbol. Clicking one more time will collapse that 
branch. 

4. Select the desired resources to backup by clicking the adjacent checkbox. Click again to uncheck the 
checkbox and deselect that resource. 

 
 


